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Welcome to the The Financial Edge End of Year Guide. This guide was written to help you with your end of year
processes. The information in this guide is organized by program. The following list contains the title of each
chapter and a summary of the information you can find in each.

Warning: Information in this guide is subject to change. Please visit our website at www.blackbaud.com to
view the most current information.

Chapter 1: Welcome. This chapter is an introduction to the The Financial Edge End of Year Guide and includes
a section detailing the various Blackbaud services and solutions we offer.

Chapter 2: General Ledger End of Year. This chapter provides detailed information on General Ledger end
of year processes such as running end of year reports, closing fiscal years, summarizing fiscal years, and
purging fiscal years.

Chapter 3: Accounts Payable End of Year. This chapter provides detailed information on Accounts
Payable end of year processes such as setting up 1099 vendors, editing distribution information, adding 1099
amounts to 1099 vendors, and reporting on 1099 vendors.

Chapter 4: Student Billing End of Year. This chapter provides detailed information of Student Billing end of
year processes such as copying and editing billing items and bill codes from one school year to the next,
adding new billing items and bill codes, promoting students to the next grade, verifying and editing student
information, and posting to General Ledger.

Blackbaud Solutions and Services

This section provides an overview of the services and training solutions we offer to help you successfully install,
implement, and use The Financial Edge.

Blackbaud Forms

Blackbaud Forms provides custom checks, student bills, statements, invoices, purchase orders, tax forms,

envelopes, and other computer forms that are specifically designed for use with The Financial Edge. Blackbaud
forms are guaranteed to align correctly and can be customized to your organization’s specifications, using your
logo, special inks, and print styles. Pre-printed forms from other suppliers are not guaranteed to align properly.

For more information, you can visit the forms section of our website at http://forms.blackbaud.com or send an
e-mail with questions to forms@blackbaud.com. You can also call 866-4-BB-FORMS (866-422-3676).

Data Services

We offer a wide range of data services. From database conversion to database consolidation, our staff of
programmers and analysts have the experience, technology, and expertise to meet your organization’s needs.

To request a quote for data services or database conversion, please contact our Conversion Coordinator by e-mail
at conversionestimate@blackbaud.com or by phone at 1-800-468-8996 x4200. You can also submit your request
from the Data Services page on our website at www.blackbaud.com/services/dataservices/asp.
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Accounting System Consulting

Accounting System Consulting services help you get the most out of your Financial Edge software by aligning
your organization’s systems with its processes and objectives. We partner with you to learn about your
organization, identify issues and plan a solution that is tailored to your needs.

Our consultants offer a uniqgue combination of accounting experience and in-depth knowledge of our software.
Many of our consultants have gained experience by serving as controllers and technical specialists and have
worked for Big Five firms, nonprofit organizations, and the Financial Accounting Standards Board (FASB). They
can share insight garnered from their work with hundreds of nonprofit organizations. Our accounting consulting
team knows the software inside and out and are available to help you make the most of your system.

To learn how your organization can benefit from our Accounting System Consulting services, call 800-443-9441 or
e-mail solutions@blackbaud.com.

Technical Consulting

Let our knowledgeable consultants bring their technical expertise to your site and manage the implementation of
your Financial Edge products. By entrusting the nuts and bolts of implementation to one of our consultants, you
ensure optimal setup of your system while keeping your time and energy focused on fostering your
organization’s mission.

Whether it is software installation or a detailed assessment of your current IT capabilities and needs, our team of
Microsoft, Cisco, and Oracle certified engineers can help you meet your technical challenges head on.

If you would like to arrange for consulting services, please call our Sales Department at 1-800-443-9441. Or send
an e-mail outlining your specific needs to sales@blackbaud.com.

To learn more about our technical consulting offerings, such as technology assessments, diagnostic services and
software installations, you can download the printer-friendly document “Technical Consulting Services” from our
website.

Training Solutions

Because we understand how important training is, we offer a variety of options to meet your different needs.
Training is a vital part of realizing the full potential of your software. It not only increases efficiency, accuracy, and
saves time, but you’ll also see a boost in your staff’s job satisfaction as they become more confident and valuable
in their roles.

For information about the best training option for your organization, check out our Training page on
Blackbaud.com at https://www.blackbaud.com/nonprofit-training/, or call your account representative at
1-800-443-9441. You can also send an e-mail to solutions@blackbaud.com.

This section provides a brief description of the training solutions we offer.

Start Learning. As a Blackbaud customer, you have access to Start Learning -- a collection of free online training
videos. Use these short product lessons to help you develop and maintain the essential skills you need to
make the most out of your Blackbaud solutions. You can access Start Learning from the Training page of
Blackbaud.com.

Blackbaud Learn. Blackbaud Learn is an annual subscription that provides the ongoing skill development and
job knowledge training your staff wants and needs, including strategy and best practices, role-based
curriculum, exclusive “Q&A” sessions, and new classes every month. There is a distinct Blackbaud Learn for
each of the following Blackbaud solutions: The Raiser’s Edge, The Financial Edge, The Education Edge, and
both Internet solutions Blackbaud Net Community and Blackbaud Sphere. For more information about
Blackbaud Learn, go to the Training page of Blackbaud.com.
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Instructor-led Training. With Instructor-led training, you can interact with our instructors via interactive online
classes or regional classes at any of our more than 50 locations across the United States and Canada, including
our training facility in Charleston, SC. We offer sessions on strategy and best practices, as well as personalized
custom trainings. For more information about Instructor-led Training, go to the Training page of
Blackbaud.com.

Self-paced Training. Self-paced training gives you access to the eLearning Library -- a collection of online
lessons that take you step-by-step through key concepts and tasks in your Blackbaud products. You can
choose from hundreds of pre-recorded lessons 24 hours a day, 7 days a week and take them at your own pace.
Plus, the eLearning Library is included with any Blackbaud Learn subscription. For more information about
Self-paced Training, go to the Training page of Blackbaud.com.

Role-based Training. Whatever your role, we’ve designed a curriculum pathway to best meet your needs.
With Role-based training, you can take advantage of classes grouped specifically to help you in your
day-to-day job. For more information about Role-based Training, go to the Training page of Blackbaud.com.

Software Maintenance Services

Our maintenance programs supplement your software purchase by providing you with tools, resources, and
support so you can use the software at its fullest potential. To meet your organization’s needs, we have several
plans from which to choose. For information about the maintenance plans, go to
http://maintenance.blackbaud.com.

Blackbaud Developer Network

The Blackbaud Developer Network (BDN) is an alliance of development partners, including system integrators,
consultants, CPA firms and nonprofit organizations, that work with us to create solutions that expand the
capabilities of The Financial Edge. These solutions are additional applications, created specifically for our
clients, that work with our software to expand functionality. For example, BDN solutions can include customized
tools and plug-ins that integrate or interact with The Financial Edge to help your organization accomplish more
in less time.

Our BDN development partners have been carefully selected. They each possess a distinct understanding of our
software products and how nonprofit organizations use them to further their mission. This insight, coupled with
technical expertise, provides the basis for creating quality solutions you can use to do more.
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Closing the fiscal year with Blackbaud’s General Ledger is a two-step process. First, you should run the pre-close
report. After the report has successfully validated your data, you can close the fiscal year to complete the
process.

Please read this chapter completely before you begin the end of year process.

The end of year process is typically run a few months after the end of the current fiscal year. This allows you time
to complete your annual audit and make any adjustments your accountant may suggest.

Running the General Ledger end of year process:

¢ Automatically calculates the net/surplus deficit for each fund and transfers this amount into the appropriate
fund balance account.

¢ Calculates the fiscal year-end closing balances for all balance sheet accounts and creates an opening balance for
these accounts for the next fiscal.

e Sets the income statement account balances to zero.
¢ Calculates the increase/decrease in net assets and calculates the ending net asset balances for the year.
¢ Permanently restricts journal entries to the closed fiscal year.

End of Year Considerations

Becoming familiar with the following issues will help you decide when to close your fiscal year.
¢ Unlimited fiscal years can be left open in the program.
¢ Unlimited fiscal years can be defined in the program.

¢ Closing a fiscal year permanently restricts journal entries to any of the fiscal periods contained in the fiscal year
you are closing.

¢ Closing a fiscal year does not delete any transaction detail. Other options are available for summarizing and
deleting transaction detail for the fiscal year.

Note: Because transaction detail is not deleted during the end of year process, printing hard copies of your
general ledger detail for the fiscal year is not a necessity.

¢ You can “soft close” a fiscal period, which restricts journal entries to a fiscal period, but allows the period to be
re-opened later for journal entries. Running the end of year process “hard closes” all periods for the year being
closed and prevents any further posting to these periods.

¢ You can run the end of year process at any future date.

Prep Work

To ensure a smooth end of year process, we recommend the following:
e Post to General Ledger from all of your Blackbaud systems.

¢ In Configuration, verify a fund balance account has been defined correctly on the Funds page. Review the
closing method for each fund to ensure the fiscal year-end close will produce the desired results.

¢ In Configuration, verify your next fiscal year has been defined.

¢ Make sure all users have exited and signed out of The Financial Edge. If the database integrates with The
Raiser’s Edge, have all The Raiser’s Edge users exit and sign out also.

¢ Make backups of your data.
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Running an End of Year Report

Warning: Backups are essential elements in completing the end of year process. They protect your data in
case of power failures, surges, or other interruptions in processing.

Running the pre-close report automatically starts a series of checks and balances to determine the process
prerequisites have been met. If they have not, an error report is generated. You can re-run the pre-close report
until a successful report is produced. Before you can close the fiscal year, you must produce a successful report.

The pre-close report will contain the following information:

¢ Alist of each fund and project (if applicable) and the net surplus/deficit amount to be posted to the fund
balance accounts defined on the fund records.

¢ The net asset code summary, which lists the net decrease/increase for the three net asset classifications.
¢ Alist of any open current year batches.

» Running a pre-close report

1. From the Administration page in General Ledger, click Close fiscal years. The Close Fiscal Year screen

appears.
@ Close FiscalYear @]

1. General |2: Fund fiIterI

Cloging Options

Action: IF'rint pre-cloze report j
Fizzal year: |2[|DD j
Report Options

Action;  [Preview Repot x| [WeKPRINTTSDOCEK =]

Orientation: I Portrait w7 I

< Bachk | Mext » | EunNowl Cancel |

In the Action field of the Closing Options frame, select “Print pre-close report”.

In the Fiscal year field, select the fiscal year to pre-close or close.

In the Action field of the Report Options frame, select “Preview Report” or “Print Report”. If you select
“Print Report”, also select a printer.

5. In the Orientation field, select “Portrait” or “Landscape” depending on how you want the report to
appear for printing or previewing.
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6. Click Next or select the Fund filter tab. The Fund filter tab appears.

@4 Close Figcal Year

1: General 2 Fund filter I

&0 0pen B Clear All Filters

Filters | Include | Selected Filers |
Funds All <Al Funds>

< Back | Ui [ | Bun How Cancel

I
7. Inthe Include column, select “All” or “Selected”.

If you choose “Selected”, the Selected Funds screen appears for you to select the funds to close. Make
your selections and click OK. You return to the Filters tab, and the filters appear in the Selected Filters
column.

Click Run Now to generate the end of year report.

9. The report will show on the screen. Make sure you print a copy for your records by clicking Print located
on the Preview screen.

Pre-closing and Closing Fiscal Years

The purpose of closing a fiscal year is to update the net asset accounts in the balance sheet with income
statement activity. At the end of the year, General Ledger adds all income statement transactions together to
calculate the net surplus/deficit for the year. It then “zeros” income statement account balances by transferring
the net surplus or deficit to the appropriate net asset accounts. In balance sheet accounts, ending balances roll
forward to the next fiscal year.

You can also pre-close a fiscal year. A pre-closing is a mock closing used to temporarily close a year speed
reporting. Because closing a fiscal year is permanent, we encourage you to pre-close each fiscal year as soon as
you finish entering and posting all transactions for the year before running the actual closing process.

Once you close a fiscal year, information remains available for reporting until it is purged. However, you cannot
post new activity to a closed year. This section contains procedures for managing the fiscal years you define in
Configuration in General Ledger.

» Pre-closing or closing a fiscal year

Warning: Before you can close a fiscal year, you must define at least one subsequent fiscal year in the program

1. From the Administration page in General Ledger, click Close fiscal years. The Close Fiscal Year screen
appears.
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If users are currently logged into the program, a list of those users is displayed. Before you can run the

pre-closing or closing process, all users must exit the program. Once all users exit the program, the Close
Fiscal Year screen appears.

& Close Fiscal Year I

1: General |g: Fund Filterl

Cloging Options -

Action; IF'rint pre-close report j
Fiscal year; I 2000 j
Report Options

Action:  |Preview Report ¥| [w2KPRINTIWDOCEK =]

Orientation: I Portrait A I

< Bach | MNext > | BunNowl Cahcel I

Warning: Because closing a fiscal year is permanent, we encourage you to pre-close before running the actual
closing process.

2.

In the Action field of the Closing Options frame, select “Print pre-close report”, “Pre-close fiscal year”, or
“Close fiscal year”.

In the Fiscal year field, select the fiscal year to pre-close or close.

In the Action field of the Report Options frame, select “Preview Report” or “Print Report”. If you select
“Print Report”, also select a printer.

In the Orientation field, select “Portrait” or “Landscape” depending on how you want the report to
appear for printing or previewing.

Click Next or select the Fund filter tab. The Fund filter tab appears.

&% Close Fiscal Year I

1: General 2 Fund filker |

&20pen B Clear All Fiters

Filters | Inciude I Selected Filters
Funds Al <4 Funds>»

< Back | Hents | BunNowl Cancel |

In the Include column, select “All” or “Selected”.
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If you choose “Selected”, the Selected Funds screen appears. Select the funds to close and click OK. You
return to the Filters tab, and the filters appear in the Selected Filters column.

8. Click Run Now. If you selected “Pre-close fiscal year” or “Close fiscal year”, a screen appears confirming
you want to pre-close or close the fiscal year.

9. To continue pre-closing or closing the fiscal year, click Yes.

If the program detects errors during the pre-closing or closing process, you can view the End of Year Error
Report to see where problems exist. To return to the Close Fiscal Year screen, close the report. This report
prints automatically without previewing it, if you choose that report option.

Note: Once a fiscal year is successfully pre-closed or closed, the status for that year will be “Pre-Closed” or
“Closed” on the Fiscal Years page in Configuration.

If the pre-close or close process is successful, a confirmation message appears.

10. To process the end of year report, click OK. The report appears for you to preview or prints depending on
the report options you select. If you preview the report, you can return to the Close Fiscal Year screen by
closing the report. If you print the report, the program automatically returns to the Close Fiscal Year
screen.

Summarizing Fiscal Years

To save space in your database, you can use the Summarize Fiscal Years utility to summarize all transactions for
closed fiscal years. During the summarizing process, the program removes all transaction detail, including
associated distributions. The program does, however, save the beginning and ending balances, as well as the total
net change for the project, class, and transaction code distribution for each fiscal period.

Warning: Before you can summarize the fiscal year, you must close it.

Once you summarize a fiscal year, you can produce reports on the beginning and ending balances and the net
change and net asset class for each account. If you have the optional module Projects and Grants, you can also
produce reports on transaction codes and projects.

» Summarizing a closed fiscal year

1. From the Administration page in General Ledger, click Summarize fiscal years. The Summarize Fiscal Year
screen appears.

i Summarize Fiscal Year

w | Fizgcal vear 1933-2000

Summarize all fiscal years through |FEEE

[ Delete batch headers if all tranzactions within a batch are summarized

Surnmarize Mow I Cancel I

2. In the Summarize all fiscal years through field, select the closed fiscal year you want to summarize.

Warning: If you mark this option and all transactions associated with a batch fall in the fiscal years being
deleted, the program also deletes the batch header record. We recommend you run a Batch Summary Report
before deleting batch headers.

3. To delete batch headers if all transactions within a batch are summarized, mark the checkbox.
4. Click Summarize Now. A confirmation message appears.
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5. To continue, click Yes. A processing screen appears. Once the process is complete, a confirmation
message appears.

Accounting for Monprofits

k}) You have succezsfully summanzed all fizcal years up to and including 1333-2000,

6. To return to the Administration page, click OK.

Purging Fiscal Years

Warning: We strongly recommend running financial statements and creating a backup of fiscal year
information prior to purging.
By purging a fiscal year, you remove all detail about the fiscal year from your database. However, the program
does not delete any account numbers and tables used in a fiscal year. Before a fiscal year can be purged, you
must close it. Before purging a fiscal year, you should run all financial statements and save or print copies to keep
for your records. We also strongly recommend you create a backup of fiscal year information prior to purging.
You cannot recover a purged fiscal year without restoring to a backup.

Note: If you do not have security rights to purge fiscal years, you cannot see the Purge Fiscal Years link on the
Administration page.

» Purging a fiscal year
1. From the Administration page in General Ledger, click Purge fiscal years. The Purge Fiscal Year screen
appears.

& Purge Fiscal Year

Fizcal ¥ear 1993-2000

Purge all fizcal years through

Purge Mow Cancel |

In the Purge all fiscal years through field, select the closed or summarized fiscal years to purge.

Click Purge Now. A confirmation message appears.

Note: To stop purging the selected fiscal year while the processing screen is displayed, click Cancel.

4. To continue the purging process, click Yes. A processing screen appears. Once purging is complete, a
confirmation message appears.

Accounting for Honprofits

\::) Y'ou have successfully purged all fizcal years up to and including 1333-2000.

5. To return to the Administration page, click OK.
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Wrap Up

After the end of year process has finished, check the system to ensure the changes have been made to your data.
¢ View the Fiscal Year page in Configuration. Note the status for the fiscal year has changed to “closed.”
¢ Print financial reports and compare them with statements printed before running the end of year process.

Questions and Answers

Question:

I have closed the fiscal year, and now | want to clear out some of the transaction detail from the year. Does
closing the year do this?

Answer:

Closing a fiscal year removes no transaction detail from the database. Two options are available to remove excess
data from the database. The Summarize Fiscal Year option nets all transactions from a fiscal period into one
figure and deletes the transaction detail. You can still run comparative financial reports for a summarized fiscal
year.

Purging a fiscal year deletes all summary transactions for the fiscal year and prevents comparative reporting for
the year purged. We recommend you back up your database before you run these processes.

Question:

When should I run the end of year process?

Answer:

Run the process at any time after period 12 of your fiscal year. Keep in mind you can leave unlimited fiscal years
open in General Ledger.

Question:

When do most people close their fiscal year?

Answer:

Most organizations run the process only after they have received their yearly audit. This allows audit adjustments
in period 12 of the past fiscal year.

Question:

How do | know whether | should lock my FAS 117 balances or not?

Answer:

Your accountant should be able to tell you if you will need to produce the FAS 117 compliant statements for the
fiscal year you are closing.

Question:

| ran the end of year report and there were a few problems, which | corrected. Is it all right to re-run the report?
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Answer:

The end of year report should be run again until there is a successful report produced.

Question:

| am not ready to close the fiscal year, but | want to restrict users from posting to past periods in the General
Ledger. Is this possible?

Answer:

You can “soft close” a period by accessing the Fiscal Years page in Configuration. This prevents users from posting
to a specific period. If you need to change the period, the system administrator can remove the “soft close” at
any time.
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As the calendar year quickly comes to an end, it’s time to start preparing 1099s for your vendors. Before you
generate your 1099s, save time and money by verifying 1099 amounts and vendor information. You can start the
verification process in December for a smoother January.

Note: Blackbaud offers quality forms, pre-printed in color with your organization’s logo and information. For
details, call 866-4-BB-Forms, visit http://forms.blackbaud.com, or send an e-mail with questions to
forms@blackbaud.com.

When it comes time to create your 1099s, you must first install the end-of-year update. This update, available in
late December, ensures compatibility with IRS regulations and forms.

Instead of processing your 1099s directly through Mail in Accounts Payable, you can now connect to Aatrix. The
Aatrix integration combines your data with their content to populate the integrated reports in compliance with
state and federal tax agency regulations. The 1099-MISC and W-2 eFiling solutions provide a range of choices
from a complete full service eFiling option to a partial eFiling of just the federal forms, state forms or both.

While we recommend using the complete eFiling option as a best practice, you could skip the eFiling option
altogether and print to paper tax forms. Please be aware, there are costs associated with eFiling. Also the new
option to eFile 1099-MISC forms impacts your decision whether to purchase paper tax forms. To purchase
compatible preprinted paper tax forms for paper or the partial eFiling options, please contact the Blackbaud
Forms team at 866.422.3676 to speak to one of our trained tax forms specialists.

Creating 1099 Vendors

Tracking a 1099 vendor involves defining information in two key areas: vendors and invoices. On the vendor
record, be sure to enter the 1099 vendor’s tax identification number (TIN) in the Tax ID number field. This
information prints on the 1099 form.
» Setting up a 1099 vendor
1. Open the vendor you want to make a 1099 vendor.

25 - ADS Security Systems !E

File Edt Yiew “endor Favortes Tools Help
E]Saveandtlose-|n X||§§|H i bk N||E| @|E|| ? - |
Mates | Higtary of Changes I Media I Actions
Mendor I Activity | Becuring | Purchase Orders | Addresses | EFT Bank Infarmation | Digtribution | Aftributes
Yendor name: IADS Security Systems
Yendar 1D 25 Address: 4328 Elliot Circle ;I
I _I Charleston, 5C 29416
Status: IActiVe j _I
Cusztomner nurmber: (132165440 T
| Contact: | [Mr. Bill-Janes
Tan D number;  [45-76541255 S |
‘ozition: District M anager [ Frint?
Terms: INet‘IE vI :\:‘I
Contact Type | Contact Murmber |
v Credit limit |$1 ooo.oo | | Business (800) 455-8336
Payment method: IChBCk j ||
Fapment options: IUne payment for all invoices j User ID: I
Bank. account: |Dperating j PIN: I
v 1099 ¥endor? | €8 1033 Distribution...

| Active |

2. Enter a Tax ID number. This number can be a Social Security Number (##-#-####) or Employer

Identification Number (H##-#HiH#HE).
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3. Click Address and select the Options tab.

% Address for ADS Security Systems

General Options IEontactI

Accounts Payable Options

Name: I

Alias: I
I¥ Primary address for vendar
[T Default address far invoices

[T Default address for purchase orders

1059 Information -

1099 name: ISm_l,lthe, Riobert /.

1099 name 2: IDBA Artists In Residence Unlimited

v Default address far 1099 forms

QK | Cancel |

4. In the Name field, you can enter the vendor name you want to print on invoices, checks, and purchase
orders that use the same address. If you leave this field blank, the name on the Vendor tab prints.

5. In the Alias field, you can enter a vendor alias. You can use alias as a filter when trying to locate vendors
from the search screen. The alias you provide does not print on any documents.

6. Mark Primary address for vendor to indicate the address is the primary address for the vendor. The
primary address appears on all invoices and purchase orders unless you specify another address as the
default.

Warning: It is important that the combination of name control and taxpayer identification number (TIN)
provided on an electronically filed return match IRS’s record of name controls and TINs.
7. Mark Default address for invoices to indicate the address as the default address for all invoices.

8. Mark Default address for purchase orders to indicate the address as the default address for all purchase
orders.

9. Inthe 1099 name field, enter the name you want to appear as the Recipient on the 1099 form. This is an
optional field.

Please be aware that what you enter in this field is pulled into the magnetic media file to serve as the
name control value, and therefore, must be formatted correctly. You must enter a person’s last name first.
For organization names, the first four characters you enter will be used.

We recommend you review the rules in the Business Name Control matrix provided by the IRS to verify
your name control prior to e-filing.

10. The 1099 name 2 field is optional. If you enter a name, it appears on the 1099 form under the 1099 Name
field.

11. Mark Default address for 1099 forms to indicate the address as the default address for all 1099 forms.
12. To return to the Vendor tab, click OK.
13. Mark the 1099 Vendor? checkbox.
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14. Click 1099 Distribution. The 1099 Distribution screen appears.

15.

16.

i 1099 Distribution for ADS Security Systems I

1099 Box Number I State I Percent I

[7[1-Rents sC =]

Digtribute Evenly  Delete All... Remaining: 100%
[~ Put acheck in box 3 of the 1099 for this Yendar
[~ Put acheck in the '2nd TIN not.' box of the 1099 for this Yendaor

ak I Cahicel

In the 1099 Box Number column, select a default box number.

When selecting a default box number, please be aware that two new box codes have been added for 2005
reporting: 15a and 15b.

In the State column, select a state from the table. You cannot produce 1099 distributions for states until
you define states and state ID numbers on the General page of Configuration.

Warning: You can define states and state ID numbers on the General page of Configuration.

17.
18.
19.

20.

In the Percent column, enter a 1099 percent. You can use the calculator or click Distribute Evenly.
To delete the information you have entered in the 1099 grid, click Delete All.

To have Box 9 checked on printed 1099 forms, mark the Put a check in Box 9 of the 1099 for this Vendor
checkbox.

To have the ‘2nd TIN not.” box checked on printed 1099 forms, mark the Put a check in the ‘2nd TIN not.
box of the 1099 for this Vendor checkbox.

Note: Once you set up a 1099 vendor, you can edit the information by selecting Edit 1099 Default Distribution
from the Vendor menu.

21.

To return to the Vendor tab, click OK.

Adding Invoices to 1099 Vendors

When you add an invoice or credit memo to a 1099 vendor, the total amount of the invoice or credit memo is
distributed to the default 1099 box. You can edit the 1099 distribution:

¢ If you do not want the entire invoice amount to apply to a 1099 box, you can reduce the distribution.

¢ If you want the amount to apply to another box, or to more than one box, you can change the distribution.

¢ If you do not want the invoice amount to apply to a 1099, you can delete the 1099 distribution.
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To access the 1099 Distribution screen, click 1099 Distribution from the invoice record.

i 1099 Distribution for Invoice 47 I
I $ % |
1099 Bow Numnber State I Arnount I
B Oterrcome  RIEE $25.00

Digtribute Evenly  Delete &ll...

Upon payment of this invoice, the amount allocated to the 1099 box automatically updates on the vendor record.
The payment date determines the calendar year in which the amount is reported. For example, any invoices
entered in December 2004 but paid in January 2005 are reported on the 1099 forms printed for 2005.

Credit Memos

You should use a credit memo to withhold Federal or State tax from a 1099 payment. The 1099 distribution of the
amount on the credit memo would be Box 4 for Federal and Box 16 for State.

To access the 1099 Distribution screen, click 1099 Distribution from the credit memo record.

&% 1099 Distribution for Credit Memo C889

1093 Box Number

Dijziniowiz Evanly L Total: $0.00

ak. I Cancel

You should use separate credit memos for each entity, and then apply the credit memos to the 1099 invoice
before creating a payment.

If the business rule for invoices, “Change invoice status to paid when applied to credit reduces the balance to
zero” is selected, the 1099 amounts will not be recorded to the vendor when this condition is met.
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Adjusting 1099 Amounts

When verifying 1099 amounts in Accounts Payable, you may find some invoices that should or should not have
been marked to be included in the 1099 information. To correct this information for 1099 printing, you can adjust
a 1099 amount at any time by selecting Vendor, Enter 1099 Adjustments.

1099 amounts can be changed by creating a 1099 adjustment for the difference between the actual amount and
the correct amount. To change the 1099 amount or state, use the following steps or our interactive 1099 Wizard,
which takes you step-by-step through the process of making adjustments and correcting information.

If you discover a vendor whose 1099 activity has not been tracked throughout the year, ensure you mark the
vendor as 1099 and define a default 1099 distribution.

1099 Adjustments for AlphaGraphics ﬂ

Enter 1033 amounts not included on invoices:

Effective Date | 1099 Box Mumber | Stake I Armount |
| |12/31/2008 1-Rents sC $100.00
| |12/31{2003 1-Rents {$100.00)

Ok, I Cancel |

Note: If you have incorrectly recorded invoices for the 1099 box, you can enter negative amounts to decrease
the vendor balance.

Effective Date. Enter a date that specifies the calendar year for which the amounts should be recorded.
1099 Box Number. Select the 1099 box into which the amount should subtotal.

State. Select a state from the table. You cannot produce 1099 distributions for states until you define states and
state ID numbers on the General page of Configuration.

Amount. Enter the 1099 adjustment amount. Enter a positive number to increase the 1099 amount. Enter a
negative number to decrease the 1099 amount.

OK. To save, click OK. You should now be able to print the 1099 for this vendor with the correct total.

Reporting on 1099 Vendors

Warning: The IRS requires you to provide payees with their copy of the 1099-MISC by January 31. The
reporting to the IRS must be done by February 28/29 (March 31, if filing electronically).

To preview 1099 vendors and 1099 amounts, you can run the 1099 Activity Report. This activity-based report
provides summary information of payments made against invoices with assigned 1099 boxes. The information is
summarized by individual box and by vendor over a specified duration of time.

You should run this report prior to creating the 1099-MISC at the end of the year. If necessary, you can open the
vendor record and enter 1099 Adjustments.

For your vendors, print pre-printed laser 1099-MISC forms to mail by January 31.

For the IRS and/or state tax departments, print pre-printed laser 1099-MISC forms to report the information by
February 28. You can also create an electronic file to report the information.


http://www.blackbaud.com/support/faqs/1099.aspx
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1099 Forms

You can create 1099s to report miscellaneous income you paid to vendors in a calendar year. Amounts reported
on 1099 forms are taken from the check date for checks printed during that calendar year. The address marked as
the primary address on the vendor record prints on the 1099.

Before you create 1099s for your organization, verify your organization’s Federal Identification Number is correct.

Print the amounts that have been entered on invoices or adjustments to 15a and 15b to the new box numbers on
the form.

You may need to report amounts in box 7 that you have reported in box 15b. We recommend you speak with
your tax accountant to determine if your organization should report amounts in both boxes.

1099 Forms Tabs

A 1099 has tabs on which you select parameters: General, Filters, and Attributes. To move among the tabs, click
Next and Back at the bottom of the screen or select the tab. On these tabs you specify the records to include in
the mailing and how the forms should look.

Warning: Before you can print 1099 forms, you must enter your organization’s Federal and State Identification
Numbers in Configuration.

1099 General Tab

On the General tab for 1099 forms, you select parameter settings specific to 1099s.

Generate 1099s for. In the Generate 1099s for field, you can select the year for which you want to print 1099
forms.

Corrected return. If you mark the Corrected return checkbox, forms print as corrected returns and are marked
accordingly on the 1099s.

Include activity below minimum. If you mark the Include activity below minimum checkbox, 1099s print for
vendors who do not meet the minimum amount required by the IRS for 1099 reporting. Marking this
checkbox activates the Include vendor with no activity checkbox.

Include vendors with no activity. If you mark the Include vendors with no activity checkbox, the program
creates 1099s for vendors with no 1099 activity for the year.

Use an alternate payer/file name. If you mark the Use an alternate payer/file name checkbox, to enter an
alternate name for the vendor.

Name. In the Name field, enter a contact name or number, up to 40 characters. Enter the phone number and
Email address fields.

Note: From the General tab, you can also print totals to use on a Form 1096. This summary prints on a
separate sheet of paper after the 1099 forms.

Print 1099 Forms. Mark Print 1099 Forms, and additional selections for printing 1099s are enabled. Mark Print
payee account # to select to print the vendor ID, attributes, customer number, or system ID. To print summary
information for a Form 1096 after the 1099s, mark the Print 1096 summary checkbox.

Note: Click Preview to view the form as it will print using your selections and filters. Click Layout to view a
sample layout of the form without data.

Create an output query of vendors. To create a query of vendors you run 1099s for, mark Create an output
query of vendors. You can save and use an output query later for other mailings or reports.

Report Orientation. 1099s automatically print in portrait orientation (vertically).
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1099 Filters Tab

You can use the Filters tab to include records based on selected criteria such as vendors or vendor attributes. For
example, you may not be preparing 1099s for all vendors at one time. You can include only those vendors whose
names begin with A through H.

Open. To open a selection screen to designate specific filters for the form, select a filter in the grid and click Open
on the action bar.

Clear All Filters. To reset each filter to include all, you can click Clear All Filters.
Filters. The Filters column lists all the filters for the form. You cannot edit this column.

Include. By default, in the Include column, each filter is set to All. To open a selection screen to designate
specific filters for the form, choose Selected.

Selected Filters. Filters you specify on the selection screen appear in the Selected Filters column.

1099 Attributes Tab

You can use the Attributes tab to add, delete, or update attributes for the vendors whose 1099 forms you
generate. For example, when printing 1099s for vendors with an attribute type of 1099 Printed and a description
of Yes, you can update the date to record the date for 1099 printing the next year.

Action. In the Action column, you can select to add, delete, or update attributes on the vendor record when you
generate 1099s.

Attribute Type. In the Attribute Type column, you can select an attribute type.
Description. In the Description column you can enter or select a description for the attribute type.

Short Description. If you selected a table type attribute that uses short descriptions, in the Short Description
column, select the attribute description. The Description column completes automatically.

Date. In the Date column, select the date you add, delete, or update the attribute.

Required. If the attribute type you select is required, the program automatically marks the checkbox in the
Required? column.

Comments. In the Comments column, you can enter free-form text for additional information about the
attribute type.

Additional End-of-Year Resources

Have additional questions about the end-of-year process? Check out these resources:

¢ Knowledgebase to find answers to how-to questions and troubleshoot software issues.

e Forums to discuss best practices with your peers and review shared Client Documents.
¢ Blackbaud Forms to order W-2 and other tax forms.



http://www.blackbaud.com/kb/index?page=home
http://forums.blackbaud.com/forums/66.aspx
https://www.blackbaud.com/blackbaud-forms
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Closing the school year with Student Billing is a multiple step process to reconcile the ending school year and
prepare for the upcoming school year.

Note: For electronically filed 1099-MISC and 1098-T forms, please see IRS Publication 1220 to review the
magnetic media changes.

We strongly recommend you read this chapter completely before you begin the end of year process.
With the Student Billing end of year process, you can complete the following tasks:

¢ Copy and edit billing items and bill codes that are used from one school year to the next and add new billing
items and bill codes as necessary.

* Promote students to the next grade.
¢ Verify and edit student information.
e Post to General Ledger.

Student Billing End of Year Checklist

Warning: The end of year process creates vast changes to the database and can be reversed only by restoring
to a backup. Backups essential in completing your end of year process. Without a valid backup, you cannot
correct inappropriate changes made in the database during the process.

To reconcile an ending school year and prepare Student Billing for an upcoming school year, we recommend you
follow each step of the checklist in order.

U Post to General Ledger.

U Reconcile Student Billing to General Ledger.

U Print end of year reports for the current school year.

Q Copy and edit billing fees that are used from one school year to the next and add new billing fees as necessary.

Qi you use bill codes on your student records, define them for the next school year. Copy and edit bill codes that
are used from one school year to the next and add new bill codes as necessary.

U Promote students to the next grade.
Q Verify and edit student information, such as addresses and relationships.

Posting to General Ledger

If the school year coincides with the fiscal year in General Ledger, make sure you post all current transactions
before you close the fiscal year. If the school year and fiscal year do not coincide, you have more flexibility.
However, to maintain consistency, we recommend you post all items before the end of the school year.

If you are planning to purge transactions, you must post all transactions or mark them as Do Not Post.
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» Posting to General Ledger
1. From the Administration page in Student Billing, click Post. The Post page appears.

[he Ldt Wew Go Fawontes Jools pisk
# Back % Forward |mnmmientssh:.' * Student Billing -

Wame | Descripton | Lot pasted by | Loct posted on |

[ Wiekecaie to Studert Biling |

2. If any post parameter files have been saved, they appear in the grid. To open an existing post, select it
from the grid. To create and post a new parameter, see “Creating and posting a new post parameter file”
on page 28.

3. To print a Batch Validation Report to review before posting, select the parameter file and click Preview on
the action bar. When the processing finishes, a validation successful message appears.

4. Click OK. A Batch Validation Report appears.

5. To post, select the parameter file and click Post on the action bar. When the processing finishes, the Post
Successful screen appears.

6. Click OK. A Post Report appears and you return to the Post page.
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» Creating and posting a new post parameter file
1. From the Administration page in Student Billing, click Post. The Post page appears.

2.

3.

[he Ldt Wew Go Fawontes Jools pisk
rmunity Services Inc. =+ Student Billing -

Administration = Post

Mew Post Passmeter Oper Delite | Preview Fost Fnd

£
£

Hame | Desription | Lastposted by | Last postedon |

i

i

i

mﬁi L

i zgé\i

EEES]

_?

il

[ Wiekecaie to Studert Biling |

Click New Post Parameter on the action bar. The New Post Parameter screen appears.

B New Post Parameter ;IEILI
File Edit Wew Favorites Tools Help
BSaveandCIosevhﬂ J\_|ul d‘3|4.'|:l'|?‘ |
General | F!Itelsl Fgrmatl
Past Student Biling transactions with this journal code: IStudenl Eillirg ﬂ
[¥ Create an output file of posted transactions in this farmat: ICumma-SeDaraled Walues j
Expart file name: I ;I

Select the journal reference to uze for each transaction twpe:

Journal Reference

Reference Type I

Debit
Credi

<Default> Last Mame/Org Mame <HyphenzTransaction Tvpe <Hyphen=C...

<Default =

Interfund entry

Last MamejOrg Mame <Hyphen=Transaction Type<Hyphen=C...

|Press F7 for file lookup ‘

4

In the Post Student Billing transactions with this journal code field, select a journal code.

4. To create an output file, mark Create an output file of posted transactions in this format, and select a file
format. In the Export file name field, enter a file name or click the ellipsis to browse.

Note: To return a journal reference to its original format, in the Reference Type column, select “<Default>".

5. To customize the journal reference format for debits and credits for each transaction type, in the Select

the journal reference to use for each transaction type frame, select a
the left. A grid appears on the right.

In the Reference Type column, select “Custom”.
In the Journal Reference column, enter the format.

transaction type from the list on
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6. Select the Filters tab.

B New Post Parameter -10f x|

File Edit Wiew Favorites Tools Help
uSaveandclosev‘u |{_Qé|'_?| . | oot

General  Filters IFgrmall

? -
i

Include tranzactions with post dates in this date range.

Puost date: Include all dates

Include tranzactions with document dates in thiz date range-

Document date Ilnclude all dates 1%

¥ Include deposits whose actual receipt totals do not match the projected totals

Filters Include Selecked Filkers Iﬂ
Records all <Al Records
Record Types all <All Record Types>
Student Attributes All <Al Student Attributes >
Individual Attributes Al <Al Individual Attribubes >
Organization Attributes al <Al Organization Atkributes>
harnes al 2ol rharness d|
alidate Post
| | 4

7. Inthe Include transactions with post date in this date range frame, in the Post date field, select a specific
date or date range of posted transactions to include.

If you select “<Specific range>", specify start and end dates.

¢ If you leave the Start date field blank, all activity up to the end date is included.

¢ If you leave the End date field blank, all activity from the start date to the present is included.
¢ If you leave both the Start date and End date fields blank, all activity is included.

8. In the Include transactions with document dates in this date range frame, in the Document date field,
select a specific date or date range of posted transactions to include.

If you select “<Specific range>", specify start and end dates.
9. To filter transactions, in the Include column for each filter type, select “All” or “Selected”.

If you choose “Selected”, the Selected screen appears so you can select the filters to create the new post
parameter. Make your selections and click OK. You return to the Filters tab, and the filters appear in the
Selected Filters column.

10. Select the Format tab.

B New Post Parameter =]
File Edit Yiew Favorites Tools Help

[L]Saveandlilnsev‘ﬂ |m.é|?| - |.)|?,

Eenera\l Filters Fgrmatl

I Use the default Post Report parameters

|
I Previgw j I

[~ Print contral report on I

Ll 1 2] 1]

or_|
|

| BN
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11. In the first field, select:

e “Use the default Post Report parameters” to use the Post Report parameter files established on the
Post Options link of the Records Options tab for General Ledger.

e “Always ask for a parameter file” to use a parameter file you select or create each time you post.

e “Always use this parameter file” to use a parameter file you select the first time you select this option
for every time you post.

If you select “Always use this parameter file”, click the binoculars at the second field. The Select a
Parameter File screen appears.

Select a Parameter File

Select a parameter file to uze for Batch Yalidation R eport

Select

%] Cancel

] Add New
(1 Open

didid

&8 Find...

[ Only show my parameter files

Select or add a parameter file and click Select. The New Post Parameter screen appears.

*

B New Post Parameter =101 x|

File Edit Yiew Favorites Tools Help
BSaveandClosev|[ﬂ |L_J.‘; d|'?| . | = g

Qenelall Filters Fgrmatl

?- |

parameter file

|Batch Dretail with Transaction level

I Preview j I

™ Print contal repart on I

L L 12

|
[ | 4

12. Inthe next field, select “Print” or “Preview”. If you select “Print”, select a printer.
13. To print a control report, mark Print control report on and select a printer in the field to the right.
14. Click Save and Close on the action bar. The Save Post as screen appears.

X
Post name: | & Save |
Description; :I Catcel |

¥ Others can run thiz Post
[+ COthers can modify this Post

15. In the Post name and Description fields, enter the file name and description.
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16. Mark whether others can run or modify the post.
17. Click Save. You return to the Post page.

18. To print a Batch Validation Report to review before posting, select the parameter file and click Preview on
the action bar. When the processing finishes, a validation successful message appears.

19. Click OK. A Batch Validation Report appears.

20. To post, select the parameter file and click Post on the action bar. When the processing finishes, the Post
Successful screen appears.

21. Click OK. A Post Report appears and you return to the Post page.

Reconciling Student Billing to General Ledger

To ensure student billing activity is correctly reflected in General Ledger, reconcile Student Billing to the
accounts receivable account in General Ledger. For more information on reconciling Student Billing to General
Ledger, see the Subsidiary Ledger Reconciliation Guide.

Printing End of Year Reports

Before you proceed, print important Student Billing reports. You can use these reports for audit documentation
and as a reference point to compare data from before and after the end of year process is complete. At a
minimum, we recommend you print these reports:

e Account Activity Report — Lists all activity for students and payers, such as charges, credits, and payments.
¢ Account Balance Report — Lists students with their grade, payers, and account balance.

¢ Account Distribution Report — Lists debit and credit amounts for General Ledger accounts created from
charges, credits, payments, and any adjustments.

e Aged Accounts Receivable Report — Lists the past due status of each student and payer.
e Open ltem Report — Lists the accounts received by paid and unpaid amounts.

» Printing a report

Note: An action bar containing links for creating a new report, opening a report, and deleting a report appears
above the list of reports. These links are common to all reports pages.

1. From the Reports page in Student Billing, click the report to print. The selected reports page appears.

SETE
Dl Lt ¥ew Go Fyeorkes Jools ek

* Back * ¢ Carnmunity Services Inc. = * Student Billing -

12 Reports - Transaction Reports

Mew Ogen Delese.. Heports

o Actin
L Account Activity Report Rsports
B Finpast
2] fbvernce Depost Hepal Arslyss
) LFT Repast F i 05
7 Frusrasd fud Sedechde el
2] Financisl &id Schedue Summ
7] Prcjeect Distribution Fieport
2] e | o Fimpcet
3] Tearsaction List
7 Testuons Flihrel Flars Hipanl
1] Unsppbed Ciedt Flapos

2. Inthe list on the left, select the type of report to print. Saved reports of that type appear on the right.
3. Inthe grid on the right, select the specific report to print.



32 CHAPTER

4. From the menu bar, click File, Print. A message appears telling you the report is printing. When the report
finishes printing, you return to the reports page.

Copying and Adding Billing Items and Bill
Codes

You can copy and edit billing items and bill codes that are used from one school year to the next and add any new
billing items not previously defined for any school year. Usually, only slight changes, such as new tuition and other
fee amounts, are needed as billing items for a new school year. If your organization needs only an increase or
decrease by amount or percentage on the items, we recommend copying the billing item information. Copying
reduces the amount of data entry and helps prevent data entry mistakes.

Billing Items

On the Products and Billing Items page, you can copy billing items that are used from one school year to the next
and increase or decrease the amount by a specific dollar amount or a percentage. You can select specific records
to copy, or you can copy all billing items. If you copy a billing item with pricing schedules, the last schedule is
copied and changed to reflect the new prices.

You can create new billing items for services you will offer in the new school year. After you add a billing item in
Student Billing, you can edit or delete the record as needed.

When you create a default product distribution on the GL Distribution tab, it automatically appears on the related
charges and credits.You can add the products and billing items:

* Flat Rate Items — Charges a specific amount regardless of the quantity or other factors; for example, a $250.00
lab fee.

e Per Usage Items — Charges the student based on the number of times the item is used, such as an hourly rate
for counseling services.

¢ Products — Defines product records and pricing schedules for items or services you will offer in the new school
year.

¢ Refund Items — Disburses credit by printing a check payable to the student or by applying the refund to another
active charge.

¢ Finance Charge Items — Charges students for the costs of financing a debt.
¢ Sales Tax Items — Charges students for purchasing certain items designated taxable by state or local law.

¢ Advance Deposit Items — Charges a refundable amount to reserve a student’s place in a future school term.
When the full payment is received, advance deposits generate credits to refund monies or reduce the student’s
existing charges.

¢ Financial Aid Items — Used as a default for creating financial aid records, which are applied to student records to
reduce the amount owed.

¢ TRP Items — Defines the tuition refund plan (TRP) percentage charge and General Ledger account to use to post
this type of transaction. You can enter the particular TRP percentage established by your school.

¢ New Automatic Item: Vary Amount by Grade — Charges the amount defined for a given year according to the
specified grade level.

¢ New Automatic Item: Vary Amount and Schedule by Grade — Charges payer specific amounts based upon the
grade level and a unique schedule defined for that grade level.

¢ New Automatic Item: Single Amount and Schedule — Charges based on a common amount, assigned to
individuals and organizations.
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» Copying billing items

1. On the Configuration page in Student Billing, from the menu bar, select Tools, Copy Products/Billing

Items. The Copy Products and Billing Items screen appears.

Etopy Products and Billing Items =131 =]

1: General |Z: F|Il&|s| B F'rewew'

Include products and billing iterms with these dates -

“Walid from date within: Ilnclude all dates Vl
Walid b date within: Ilnclude all dates vl

[V Change unit/per usage price of copied iterms by Iamount -
Ilncrease - l original amout by I [=]

|~ Change unit price on pricing schedules of products

[~ Change schedule dates that fall an a weekend to I The previous weekday ‘l

[ Frirt & contral report on j

< Back | Next = | Cancel | F're-cupyrepurll Copy now |

| | A
In the Include products and billing items with these dates frame, select a date or date range in the Valid
from date within and Valid to date within fields.

If you select “<Specific range>", specify a start and end date. If you leave the Start date field blank, all
activity before the end date is included. If you leave the End date field blank, all activity after the start
date is included.

To change the unit or per usage price of the copied fees, mark Change unit/per usage price of copied
items by and select “amount” to change the dollar value of the fee or “percent” to change the fee value
by a percentage.

Select to increase or decrease the amount or percentage, and then enter the change value in the original
amount by field.

To change the price on the copied item pricing schedules, mark Change unit price on pricing schedules of
products.

To change the schedule dates from weekends, mark Change schedule dates that fall on a weekend to and
select “The previous weekday” or “The next weekday”.

To print a control report, mark Print a control report on and select a printer.
Click Next or select the Filters tab.

Etopy Products and Billing Items =131 x|
1: General 2 Filters |§: Previewl

@5 0pen 7 Clear &ll Fiters

Filkers I Include Selected Filters

Products and Eiling Item Types Al <Al Praducts and Eilling Item Types:>
Products and Biling Items all <Al Products and Billing Items=
Product and Billing Item Attributes Al <Al Praduct and Billng Item Attributes=

< Back Hext > Cancel Pre-copy report | Copy now |

| 4
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7. You can filter by products and billing item types, products and billing items, and product and billing item
attributes. In the Include column for each filter type, select “All” or “Selected”. To copy only billing items
with specific information, choose “Selected”.

If you choose “Selected”, the Selected screen appears so you can select the billing items to copy. Click OK
and you return to the Filters tab. The filters appear in the Selected Filters column.

8. Click Next or select the Preview tab. Products and billing items that meet your specifications appear in the
grid.

ﬂtopy Products and Billing Items =10l x]
1: Generall 2 Filkers ~ 2: Preview
Copy? Item Type ©ld Start ©ld End Tews Stark Mew End Old Amount | Mew Amounk !
¥ PURGE BAL Flat Rate Item 07/01/2006  06/30/2007  OF(01/2007  08(30/2008
¥ BOCKS Flak Rate Ttem 07/01/2009  06/30{2010  07j01/2010  0&/30/2011  $0.00 40,00
¥ TUTOR Per Usage 1., O7/01/2009  06/30{2010  O7j01/2010 06(30/2011  $25.76 §25.76
¥  REFUND Refund Ttern  O7/01j2009  06/30f2010  07/01/2010  06/30j2011
¥ FINAMCE CHG Finance Ch... 07/01/2009 06/30f2010 07/01/2010  06/30/2011
¥ TRP TRP Charge... D7/01/2009  06/30/2010  OF/0L/2010  06f30/2011
¥ AID ANMUAL Financial &id  07/01j2009  06/30{2010 070142010  0/30/2011  $0.00 40,00
¥ ADVDEP Advance D... 07/01/2009 06/30{2010 07j01/2010  0&/30/2011  $0.00 40,00
[V AIDSEMI Financial 4id  07/01/2009  06/30/2010 07012010  06/30/2011  $0.00 $0.00
¥ AID 10PAY Financial &id  07/01j2009  06/30{2010  07/01/2010  0/30/2011  $0.00 40,00
[V TUITIOM AMMUAL  Automatic L., 07/01/2008 06/30/2009 07/01/2009 06/30/2010 $14,422,80 $14,422,80
[V TUITIOM SEMI AM... AutomaticI... O7f0Lj2008 O08f30/2009 OF/01/2009  06/30/2010  $14,937.90  $14,937.90
[ TUITIOMTEMPAY  Automatic I.. 07/01/2008 06/30/2009 O7/01/2009 06/30/2010 $15,246.96  $15,246.96
¥ GRaD Automnatic .. 07/01/2008  06/30{2000  07/01/2009 06/30/2010 250,00 $250,00 =
< Back | HEsts | Cancel | Fre-copy report | Copy now |
| 4

9. To copy all records, click Select All.
To unmark all checkboxes, click Deselect All.

To select specific records to copy, mark the checkbox in the Copy? column.

10. To view a report of the records to be copied, click Pre-copy report.

11. To copy the products and billing items selected, click Copy now. A processing screen appears. When the
process is complete, a screen of the products and billing items copied appears.

Note: The number of records that did not copy successfully appears in the Exceptions row of the grid.

12. When you close the screen, a screen appears displaying the number of records processed and the number
of exceptions.

Copy Products and Billing Items

Processing Completel

. Copy Products and Billing ltems

Processed:

19

Exceptions:

Cloze || Wiew Control Report I

13. To view the control report of the copied records, click View Control Report.

14. To return to the Products and Billing Items page, click Close.
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» Adding a billing item

1.

T ihe inancisl Ldoe
e Edt Yew o Fovorkes Jook Help

From the Configuration page in Student Billing, click Products and Billing Items. The Products and Billing
Items page appears.

=18l

* Bk + vl | Community Sorvices Inc, = = Studont Biling *
% e * Configuration « Products and Billing Items
i NP om0 o v et Fod Fpem ]
[] o st st e Vol rom Vol e e 'ﬂ Soed_|
1 1 | - - = 1
‘9 . v v Lnage [Lem 071012000 06/3072001 ractive it
= P Prochat o201 06130/ Inaetive el
oy Export Fieer Rosfund Ttem 07 i {2000 00 Irusctive
W 1o 04 F
Mewr Fnarce Charge Ttem 07012003 06302004 Inactive Buies. |
'g Pomr S Ta T 7oL 0613020005 Insctivie —
Lo P Achvarucr Dipacridt Toem 070112005 b 30 2000 Inactive Freks
114 e e s o7 2006 Dapa0z00T [ |
Hows TR Thom o7 o LIE e Irictive : 2
‘W Mews Bukoematie: [tom: Vary Ameurk By Grade 070200 OB JfE0L IRactive g d
e Inderburd |
-, Nvwe e oesatic e Vaey Aemewrt aevd Schechie By Grade 0012001 06302202 Tnaction
WY Barks [ — it o701 {2002 wm.:am Inactive -W“un |
e 0T Dol {0 Inativg
Admnntration |l Cee s Bk Steee Charges Q7)1 2004 DA 30{2005. Irusctive “m:' ‘*n
Bocks R Sherm Chiwgen. 0701 {7008 06/30{7008 Aetive Do
ok stion (==Y ook Store Charges 007 {0 O Adtihie Aucounts |
=+ DS Book Store Charges Ly 0200 Active Scheddes |
\Eﬁ' Schocd Storw Bocxs Bk Shorr Charges 070 70s D8 [307005 et =
= Marusger Produts
BoChs Book, Store Charges 07012009 067307200 Active and g
(- Dtbond pooes ook Stare Changes DD e TR active L
o a7 ’ Addressen ||
TR Tuboring Foe 0700 {2000 04 30{2001 Iractree o |
TUTCR Tuterir Fee o7 72001 06/ 3012002 Iractive " |
TuTcs Tuboeiny Fee o7z I T trisctive Sohedde |
TuTon Tutoeirg Fen 070112003 087302004 Iractive onl
o Tuberiey Frn 0701 {2004 DE[32005 Tt Storm |
(N Tutaring Fee urfonfas 0 507006 fctive Lt

2. Click the down arrow next to New Flat Rate Item and select a billing item. For example, to add a new per

3.
4.
5.

usage item, select New Per Usage Item. The <ltem Type> Item screen appears.

. New Per Usage Ttem

File Edit View BilingItern Fawvorites Tools Help

B save ondCiose <[ [ [ 1a S| M < b m| ]2 -

x]

=1l x|

Item ID: | - Status; IADlive -

Deescription: I
Dates: Item can be used on ary date 'I

ltem | GL Distibution | Attibutes | Netes |

Uit price decimals: |2_:|| 7 Allow user to edit unit price on transactions
Quantity decimals: Ia_j

Default valies: [ o of Measure_| Quartity | unit Price

Extended Amount

0,000

I ltem is subject to sales tax: - I ltem is eligible for discount

I™ ltem is subject ta finance and late charges

I Limit chages tor | per: |Ehalge for Recard j
Limit charges by |<AH dales E
IF a charge would exceed the limit: | Display 2 warring message ¥

Comment:

[ v

In the Status field, select “Active” or “Inactive”.

In the Item ID field, enter an identification number for the billing item.

In the Description field, enter a description to help identify the billing item.

Tip: To enter today’s date, press the F3 key. To open the calendar, click the calendar or press the F7 key.

6.

In the Dates field, select the dates the billing item: “Item can be used on any date” or “Item can only be
used from”. If you select “Item can only be used from”, enter the dates during which the billing item can
be used.

7. Complete the Item, GL Distribution, Attributes, and Notes tabs for the new billing item.
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8. Click Save and Close. You return to the Products and Billing Items screen, and the new billing item
appears in the grid.

Bill Codes

Bill codes link billing items and student, individual, or organization records. When you generate transactions
automatically, Student Billing matches the bill codes on the records to the bill codes on the billing items to create
billing schedules and generate charges.

» Copying bill codes

1. From the Administration page in Student Billing, click Copy bill codes. The Globally Add Bill Codes screen
appears.

Globally Add Bill Codes 3 |

File Help

R ?-

Add new bill codes or copy existing bill codes ta a group of records

Action: &,dd Bill Codes

Gluery name: I ﬂ
Bill Code: I j

From: I Ta: I gl

[~ PFrirt control report I~ Create exception quen

Cancel | Preprocessing Report | Add Mowe |
| |
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4.

3.

2.

Buery type: I Recard j Description: I
Query farmat: I j Created by: I
Query name: || j Created on:

Globally Copy Bill Codes

File Help

@l

Add mew bill codes or copy exigting bill codes to a group of records

Action:

Bill Codes

Query name: ﬂ
Copy bill codes ending on: I il

I~ Print contral repart [~ Create exception quemn

hizlude these bill codes:

D escription I [ escription

Annual Pagment Plan

Semi Annual Plan
Ten Payment Plan

2l ¥l

Cancel |

PFreprocessing Report |

In the Query name field, click the binoculars.

In the Action field, select “Copy Bill Codes”. The Globally Copy Bill Codes screen appears.

The Open Query screen appears.

Dpen Query

Findt: I [uery j

[ iz ﬁ Add a Mew Query

Optiohs

Hide Filters | Clear Filtersl Previous FiItelsI Filters are not applied Find Maw I
|F'ress F7 to zoom

{0 J]=lg] I

Cancel I

In the Find Queries that meet these criteria frame, enter the criteria to find the group of records.

5. After you enter the search criteria, click Find Now. The program searches the database, and all groups of

records that meet your criteria appear.
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6. Select a group of records and click Open. The Globally Copy Bill Codes screen appears.

Globally Copy Eill Codes |

File Help

NERE |

Add new bill codes or copy existing bill codes to a group of records

Aetior:  [Capy Bil Cades |
Query name: IAII students ﬂ

Copy bill codes ending an: I EII

I~ Print control repart I~ Create exception query
Include these bill codes:

Dezcription | Description
Annual Payment Plan
Semi Annual Plan
Ten Payment Plan

alr Bl

Cancel | Preprocessing Report | LCopy Maw |

|F'ress F7 for query lookup |

Tip: To enter today’s date, press the F3 key. To open the calendar, click the calendar or press the F7 key.

7.

In the Copy bill codes ending on field, enter the date on which the bill codes to be copied end.

8. To print a control report on your default printer, mark Print control report.

10.

11.
12.
13.

14.

15.
16.

To create a query of records not included in the process, mark Create exception query.

In the Include these bill codes field, select the bill code descriptions from the list on the left to include in
the process.

To view a preprocessing report, click Preprocessing Report.

To copy the bill codes to the selected group of records, click Copy Now. A confirmation message appears.
To continue the copying process, click Yes.

¢ If you did not mark Create exception query, a processing screen appears.

¢ If you mark Create exception query, the Save Static Query screen appears. Click Save. A processing
screen appears.

Once the copying is complete, a screen appears displaying the number of bill codes copied and the
number of exceptions.

To view a control report, click View Control Report.
To return to the Administration page, click Close.
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» Globally adding bill codes

1. From the Administration page in Student Billing, click Copy bill codes. The Globally Add Bill Codes screen
appears.

Globally Add Eill Codes i |
Fil= Help
QR ?-
Add new bill codes or copy existing bill codes to a group of records
Action:
Guemny name: I QI
Eill Code: I j
Fram: I Ta: I
I Frirt control report [ Create exception quemys
Cancel | Preproceszzing Report I Add Mow |
2. In the Query name field, click the binoculars. The Open Query screen appears.
Dpen Query ﬂ
Find: IGuel}l j
& = A addaN ew Query Options
M| Exact match only
Queny bype: IHecord j Diescription: I j
Query format: I j Created by: I ﬂ
Quem narme: || j Created on: I i]
Hide Filters | Clear Filtersl Brevious Filtelsl Filters are not applied IWI Hpen | Cancel |
|F'ress F? to zoom
3.

In the Find Queries that meet these criteria frame, enter the criteria to find the group of records.

4. After you enter the search criteria, click Find Now. The program searches the database, and all records
that meet your criteria appear.
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5. Select a group of records and click Open. The Globally Add Bill Codes screen appears.

6.

Globally Add Eill Codes x|

File Help

QR - |

Add new bill codes or copy existing bill codes ta a group of records

Action:

Query namne: IAII shudents QI
Bill Code: I j

Fon | 3| 3

[~ Print contral report I~ Create exception query

Cancel | Preprocessing Report | Add Maw |
| |

In the Bill Code field, select the bill code description to add to the selected group of records.

Tip: To enter today’s date, press the F3 key. To open the calendar, click the calendar or press the F7 key.

7.

In the From and To fields, enter the date range for the added bill codes.

8. To print a control report on your default printer, mark Print control report.

10.
11.
12.

To create a query of records not included in the process, mark Create exception query.

To view a preprocessing report, click Preprocessing Report.

To add the bill codes to the selected group of records, click Add Now. A confirmation message appears.
To continue the adding process, click Yes.

¢ If you did not mark Create exception query, a processing screen appears.

¢ If you mark Create exception query, the Save Static Query screen appears. Click Save. A processing
screen appears.

Once the copying is complete, a screen appears displaying the number of bill codes added and the
number of exceptions.

The Financial Edge - Globally Add Bill Codes ﬂ

. The Financial Edge - Globally Add Bill
. Codes Completel

| fBill Codes processed: 52!
Bill Codes added: 51

Exceptions: 1

Cloge || Wiew Control Report I
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13. To view a control report, click View Control Report.
14. To return to the Administration page, click Close.

» Adding bill codes to a specific record
You can add bill codes to a specific student, individual, or organization record.
1. From an open record, select the Bill Codes tab.

O Hunter Adams & 10l x|
File Edit Yiew Student Favorites Tools Help

uSaveandCIosev||ﬂ|@v|N 4 kW ﬂ?|ﬁl|g|j|?v |

Defau_ItSc..I Payers |Statements|EFT Banl_ﬂsIAgtomatic...I Actionz IAttriI;utesI Motes I Media I Hiztory I
Bioll Bio 2 | Addresses | Addressees/S alutations | Relationzhips | Activitg  Bill Codes | F_inancialAid.&ppIicationl

™ Delets.. Copy from...

Eill Code Description Skark Date End Date

2. Inthe Bill Code column, select the bill code to add. The bill code description appears in the Description
column.

Tip: To enter today’s date, press the F3 key. To open the calendar, click the calendar or press the F7 key.

3. Inthe Start Date and End Date columns, enter the date range the bill code begins and ends.
4. To save your changes and close the record, click Save and Close.

Promoting Students

When the school year is complete, we recommend you promote your students. The students are promoted
according to the Promotion Schedule you defined in Configuration.



42 CHAPTER

» Promoting students

1. From the Administration page in Student Billing, click Promote students. The Promote Students screen
appears.

i, Promote Students x|

File Yiew Help

a2

1: General

a Filtersl 3 Attributes | 4: Preview

Update retumning students

Billing status: | =l
¥ Update graduating students

Billing status: I j

Errolimert status: I =]

Graduation date: I‘I 0411/2005 EII
Date enrolled to: I‘I 0142005 EII
Reason left: | j

[~ Update grads left

[~ Create exception query of students
I~ Create output query of students
[~ Print a contral report on I j

< Back | Mext > | Lancel | Prepracessing Fleportl Process Maw I

|F'ress F7 for table lookup |

In the Billing status field, select the billing status to use for returning students.
3. To update the status of graduating students, mark Update graduating students.

¢ In the Billing status, Enrollment status, Graduation date, and Date enrolled to fields, select the
statuses and dates to which the student is enrolled.

¢ To indicate a special reason the student left, in the Reason left field, select “Relocation”, “Transfer”, or
“Medical”. Otherwise, leave the field blank.

¢ To update the Grade left field on the student records to the grade of the students before graduating,
mark Update grade left.

4. To create a query of students not included in the promotion, mark Create exception query of students.
5. To create a query of students included in the promotion, mark Create output query.
To print a control report, mark Print a control report on and select a printer.
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7. Click Next or select the Filters tab.

. Promote Students x|
File Wiew Help
SIEIRE \
1: General 2 Filbers I§: Attributesl 4 Pleviewl

&5 Open 5, Clear All Filters

Filters | Include | Selected Filters |

Skudents Al <Al Students =

Current Grades Al <Al Current Grades >

Billing Statuses Al <4l Biling Statuses:

Owiner Bill Codes all Al Owner Bill Codesz

Skudent Attribukes Al <Al Student Atkributes =

< Back | MHest » | Lancel | Prepracessing Report | Process Mow I

Note: To be included, the Owner Bill Codes selected must apply to the current date.

8. To filter the records included in the promotion, in the Include column, select “All”, “Selected”, or, for the

Owner Bill Codes filter only, “None”.

9. If you choose “Selected”, the Selected screen appears so you can select filters to promote students. Make
your selections and click OK. You return to the Filters tab, and the filters appear in the Selected Filters

column.
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10.

11.
12.
13.

14.

Note:

15.

Click Next or select the Attributes tab.

. Promote Students x|
Ele Wiew Help
QR -
1 Generall 2 Filters ~ 2: Attributes Iﬂ: Pleviewl
Action I Attribute Type | Description I Short Description Date | Required |
| r
4] | il
< Back | Hext » | LCancel | Preprocessing Report | Process Mow I

In the Action column, you can update, add, or delete student attributes during the promotion.

In the Attribute Type column, select an attribute type.

In the Description column, enter or select a description for the selected attribute type.
If you select an attribute type that uses a short description, select its description in the Short Description

column. The Description column updates automatically.

In the Date column, enter the date you add the attribute or another date relevant to the attribute.

If the attribute is required, Required is marked.

In the Comments column, enter any additional information about the attribute.
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16. Click Next or select the Preview tab.

. Promote Students |
Eile Wiew Help
alR2-
1: Generall 2 Filtersl 3 Attibutes & Preview
ctal 4t Find
denk I | Student Mame | Previaus Grade | Mexk Grade |ﬂ
v STUDZ3 Greq Skuart Atreva 01 01
v 0319 Paul Beisel 01 it}
v 0315 Jason Dugas 01 01
I STU0ZS oy Perez o o
I STUO04 Michael John Steinmeyer o o
v 0130 Dora Butler 0z 0z
v 0132 allison Carmichael 0z 0z
v 0128 Thamas Connelly 0z 0z
I 0316 Kevin Dugas 02 02
v 0317 Susan LaMonica 0z 0z
v o1za Elijah Shuart 0z i
v 0127 Jaroh Walker 0z 0z
v 0131 Maura Woods 0z 0z
v 0125 Hannah Elake 03 03
v N1z Sean Hace n= n= ﬂ
< Back | THest > | Lancel | Frepracessing Repart | Frocess Maw I
[Included: 247 Excluded 0 [

17.
18.
19.
20.

21.
number of exceptions.

To deselect a student for promotion, unmark the checkbox in the Promote column.

To review the changes before processing, click Preprocessing Report.

To promote the students, click Process Now. A confirmation message appears.

To continue the promotion process, click Yes. A processing screen appears.

Once the promotion is complete, a screen appears displaying the number of students processed and the

Promote Students

. Promote Students Completel

x|

# of Students Included

246!

# of Students Processed
# of Exceptions

Elapsed Time

Cloze || Wiewy Control Report I

246
a
0o0:00:13

22. Toview a control report, click View Control Report. Otherwise, to return to the Administration page, click

Editing and Verifying Studen

Warning: Before you begin processing the next school year, make
correct.

t Information

sure the student profile information is
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After the students have been promoted, we recommend you review and manually update any student records.
Sometimes, biographical, parent/guardian, or billing information is incorrect, and changes are needed. The
Student Profile Report shows the student record and summary transaction information for a specified period of

time.

» Creating a new student profile report

1. From the Reports page in Student Billing, click Student/Individual/
Organization Reports. The Student/Individual/Organization page appears.

2. Inthe list on the left, select Student Profile Report.

[ The: Financial Edge {Sampile Dat.a)
[le Edt wew Go Fgwontes Jools pel
Community Services Inc. * + Student Billing *

* Dack # oo
12 Reports - Student/Individual/Organization Reports

Hew Dpen Delete

7] Aoeount Baance Repart

1 Famdy Dreclony

2] Indenidusl Profle Repont

] (ngancahion Finkke Hepor
2] Payment Responsibiity Repar
] Reroud Statissies Repont

Sludent Prohle Reporl

SETE]

I3 New Student Profile Report
File Edit

BEa3a@ = 2-

‘Wiews Favorites Tools  Help

1: General IZ: Fillersl an Formatl

Show these repart sectiohs: Show these details:

v &ddress Information a| |[v 55N

[¥ sddiessees/S alutations [¥ Mickname

[V Relationships [V Current grade

[¥ Enraliments [V advisor

[~ Account Summary [¥ Homeroom teacher
[¥! Bill Cades [ Hameraom

¥ Finanrial Aid = | itk dete

[™ Show ending balance as of -
Az of date: IToda}l vl 101242005

I | Beduce balanee by ungenerated financial aid?

I | Beduce balanee by unaenerated| advance deposits?

Show year-to-date information as: IThig figcal pear vl 07140742008 ba 12431 /2005

[~ Create an output query of students

Report onentation; I Partrait e I

< Back | Mest » | Cancel | Frint | Preview |

Layout |

4. In the Show these report sections box, mark the student information to include in the report.

5. In the Show these details box, mark the more detailed student information to include in the report.

6. To show the ending balance for the students, mark Show ending balance as of. In the As of date field,
select “Today” or enter a specific date for reporting ending balances.

To reduce the ending balance calculations and account summary balances for ungenerated financial aid or
advance deposits, mark Reduce balance by ungenerated financial aid and Reduce balance by

ungenerated advance deposits as necessary.
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7. If you mark Account Summary in the Show these report sections field, select “This fiscal year”, “This
calendar year”, or “The year beginning on” in the Show year-to-date information as field.

If you select “The year beginning on”, enter the date on which the year begins in the Date field.
8. To create a query of the student records created for the report, mark Create an output query of students.
9. Inthe Report orientation field, select “Portrait” or “Landscape” to indicate how you want the report

printed.
10. Click Next or select the Filters tab. You can filter by Students, Current Grades, Billing Statuses, and Student
Attributes.
I New Student Profile Report x|
Eile Edit \iew Favaorites Tools Help
oS o= 2- \
1: General  2: Filters |3: Format'
&5 Open 7, Clear All Filters
Filters I Include I Selected Filkers
Skudents All <Al Students >
Billing Statuses all <Al Biling Statuses =
Current Grades All <Al Current Grades:=
Student Attributes all <all Student Attributes =
< Back | Next = | Cancel | Print Prewview Lapout

11. Inthe Include column, select “All” or “Selected”.

If you choose “Selected”, the Selected screen appears. You can select the filters to create the student
profile report. Make your selections and click OK. You return to the Filters tab, and the filters appear in
the Selected Filters column.
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12. Click Next or select the Format tab.

I3 New Student Profile Report x|

File Edit | Wiew Favorites Tools Help

dasaw al= 2- |

1 Generall 2 Filters 3 Format |

B Headings Headin gs
Criteria

Sart —Heading Faormat
Page Footer Title: IStudent Frafile Repart
Fieport Footer St I

Miscellaneous
Aligr: ICenter Yl

¥ Piint arganization name in header

¥ Print Page Mumber in Heading [V Frint Feport Date in Heading
Format: IF'age 1 j Format: IShort Date and Time j
Aligr: IHight j Aligr: ILeft j

¥ Piint report heading on each page

< Back | et > | Cancel | Frint | Presvigw | Lapout

Note: In the Title and Subtitle fields, you can enter up to 60 characters.

13.
14.
15.
16.

17.

In the Title and Subtitle fields, specify the heading to appear at the top of the report.
In the Align field, select “Left”, “Center”, or “Right” to select the heading alignment.
To print your organization’s name in the heading, mark Print organization name in header.

In the Print Page Number in Heading and Print Report Date in Heading frames, select whether and how
to show the page number and report date in the heading.

To print the heading on each page, mark Print report heading on each page.



18. In the list on the left, select Criteria.
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I New Student Profile Report
File Edit

d

Wigw  Faworites  Tools

BB a|=[2-

Help

1 Generall 2 Filters  3: Format |

[v Print theze criteria on Ia zeparate page 'l

. Sort

Page Footer
Feport Footer
Mizcelaneous

Saved report name

Report zections o include

Report details to include

Show ending balance as of

Show year-to-date information as of

Students to include

Student attibutes to include

Current grades to include

Billing statuzes to include

Reduce balance by uhgenerated financial aid
Reduce balahce by unhgenerated advance deposits

< Back | et » | Cancel | Print | Presvigw |

Lapout |

19.

To print a list of the criteria you used to create the report, mark Print these criteria on and select “a

separate page” or “the first page”. The program automatically selects all criteria to be printed.

20.
21.

To deselect any criteria from the list, unmark its checkbox.
In the list on the left, select Sort.

I3 New Student Profile Report
File  Edit

dadam - -

Wiew Favorites Tools Help

1 Genelall 2 Filters 3 Format |

Headings
Criteria

Sort

B Sort Sort by I

Order by I

Page Footer
Report Footer
Miscellaneous

Student I Ascending

[ Page break on each new Student D

< Back | et » | Cancel | Frint | Previgw |

Layout |

Note: If you do not select a sorting category in the Sort by column, the program automatically sorts by the

student name in ascending order.
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22. To select the order in which information appears on the report, select a sorting category in the Sort by
column and then select “Ascending” or “Descending” in the Order by column.

23. To print each sorting category selected in the Sort by column on its own page, mark Page break on each
new.

24. In the list on the left, select Page Footer.

A& New Student Profile Report x|

File Edit Mew Favorites Tools Help

dagamal=?- |

1 Generall 2 Filters  3: Format |

Headings Page Footer

Criteria ST

St ~ Page Footer Tex
‘B Page Footer Text:
Report Footer
Mizcelaneous

Align: I Center ¥ l

[ Print Page Mumber in Footer ———— [~ Print Report Date in Footer —————
Farmat: IF'age 1 j Farmat: IShort Drate and Time j
Aligre [Fight = | | s [Len =

< Back | Hest = | Cancel | Frint | Preview | Layout |

Note: In the Text field on the Page Footer Text frame, you can enter up to 254 characters.
25. Inthe Text field on the Page Footer Text frame, specify the footer to appear at the bottom of each page.
26. Inthe Align field, select “Left”, “Center”, or “Right” to select the footer alignment.

27. Inthe Print Page Number in Footer and Print Report Date in Footer frames, select whether and how to
show the page number and report date in the heading.



28. Inthe list on the left, select Report Footer.
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I3 New Student Profile Report

File Edit Wew Favorites Tools Help

dadag ol -

1 Generall 2 Filterz ~ 3: Format I

‘8 Feport Footer
Miscellaneous

Aligri I Left - I

Headings Report Footer
Criteria B
Gt eport Footer Tex
Page Foater Test:

< Back | Hext = | Cancel |

Print | F'leviegl Layout |

Note: In the Text field on the Report Footer Text frame, you can enter up to 254 characters.

29. Inthe Text field on the Report Footer Text frame, specify the footer to appear at the end of the report.
30. Inthe Align field, select “Left”, “Center”, or “Right” to select the footer alignment.

31. Inthe list on the left, select Miscellaneous.

I New Student Profile Report x|
File Edit Yiew Favoriies Tools Help
FIEEEEEETRE |
ilE Generall 2 Filkerz 3 Format |
Headings Miscellaneous
Critetia
Sark Shows currency character on Al armaunts
Page Footer Show percent sign on all amounts
_ port Footer Megative amount format (1234.56)
LI WS Mumber of digits after decimal For amounts 2
Mumber of digits after decimal For percentages 2
Show 1000's separator Yes
Shows blanks instead of zeros Mo
Font size g
Sample amount;
Amount ($1,234.56)
Percent 100.00%
< Back | st > | Cancel | Print | Preview | Layout

32. Specify how numbers will appear on the report and select the font size.
33. To view the layout of the report, click Layout. A Student Profile Report layout appears.
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